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POWERUP! INTRODUCTION 

What is this? What am I doing here? 

The PowerUp! Sessions are designed to give you a quick shot of knowledge. With these 
sessions, you will: 

1. Stay up to date on new features in 365 as they are released and deployed to your device 
(every 6 months or so). 

2. Learn interesting facts not covered in the regular Power User Sessions. 
3. This is not an extensive list of all the updates, but some of my favorites (and hopefully 

yours too!). 

Full Trainings on Microsoft Office 

This is not a full training. For information about full trainings on these products, check out the 
Power User Program section below. 

 

Back to top 

POWERPOINT 

Live Subtitles 

Live Subtitles are a very exciting new feature to appear in PowerPoint. This is a huge win for 
accessibility, and an amazing example of AI magic in Microsoft. This may not yet be in your 
ribbon, but it will be soon. 

1. Go to the Slide Show tab, Captions and Subtitles group 
2. Select Always Use Subtitles 

 

3. Select the Subtitle Settings dropdown to see a list of additional options. 
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Note you have the ability to translate a spoken language 
to a different subtitle language. This is not a perfect 
science, but is continuously being honed and developed 
by our friends at Microsoft. 

 Important: you need to have a microphone on 
the computer you are presenting on in order for 
subtitles to work. 

 

 

 

Design Ideas 

Word and Excel are also going to have an Ideas feature, but it is especially exciting in 
PowerPoint. There are a couple ways to access Design Ideas: 

 The feature may randomly appear on the right side of your screen as you are creating 
your presentation. 

 Design tab, Designer group. 

 

1. Start creating the content of your slide. Select the layout you would like, and insert the 
content you intend to use, including pictures. 

2. If Design Ideas don’t appear, select the button either in the Home tab or the Design 
tab. The Design Ideas feature will appear on the right side of the screen. 
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3. Select the desired design to alter the slide. 
 

 Design Ideas will also pick up on your content and include appropriate icons. If it 
guesses incorrectly, you can replace them with new icons via a right click menu. 

 

Icons and 3D Models 

You will also see Icons and 3D models in Word and Excel, so keep an eye out in those 
programs! Both of these features will be found on the Insert tab in the Illustrations group. 
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Icons 
If you select icons, you will be able to browse by category or search (upper left) by a specific 
term. 

 

3D Models 
3D models are available both with and without animation. 

 Click on the dropdown for 3D Models and select From 
Online Sources to see available options. 

 Notice you may also enter a search term if you are looking 
for something specific. 

 

 

 

 

 

 

 

 

 

 

Once you insert a 3D model, it can be rotated either by clicking and dragging on the circle in the 
center of the image: 
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…or by making adjustments in the ribbon. Notice that animated 3D models may also have 
different Scene options. 

 

Morph Transition 

There is a nifty new transition in PowerPoint 365 called Morph.  

 

This transition works best when you are making minor alterations between one slide and the 
next; for instance, a list where items will be added or removed to demonstrate the change. It is 
particularly stunning for SmartArt. Below is an example of a SmartArt list with a couple of 
additions between slides.  
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On the second slide, the Morph transition will be applied. I hope you came to the in person 
PowerUp! Session to experience this cool effect, because it is awfully hard to capture in print 
and much cooler to see live. 

 

Back to top 

 

WORD 

Accessibility Updates 

The accessibility features in 365 are amazing. I think it is worth it to upgrade for the accessibility 
features alone. Not only do you get live subtitles in PowerPoint (above), but your usual 
accessibility tools work even better. 

Status Bar Accessibility Checker 
In addition to the same Accessibility Checker you know and love (come to Word Essentials to 
learn about this), you also have the ability to add a live accessibility checker to your status bar. 

 

To add this cool feature to your Status Bar, right click on the Status Bar, and select 
Accessibility Checker. 
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You will see in real time if there is an issue that needs to be investigated. Simply click on the 
checker in the status bar to open the live checker. 

 

Color Contrast 
This is incredible. Up until now, you needed to download a separate program to check contrast. 
You might get a reminder in programs like Adobe to check your contrast, but it wouldn’t tell you 
whether or not it was acceptable. Now Word has this ability. 

The table below has questionable contrast…  

 

 Notice how the accessibility checker on the right is now pointing out hard to read text 
contrast.  
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 Click on any of the words in the checker to go to the location of the contrast issue. 

Alt Text 
Office 2016 really made us work to find Alt Text. Here is the good news, it is so much easier to 
access and use in 365. This will work the same in all your Office programs. 

 First, Alt Text is now a button in your contextual Picture Tools tab. This makes it so 
much easier to add alt text as you are inserting pictures. 

 Second, Alt Text is also visible on a right click menu over pictures. 

 

 

 

Draw Tools 

Your Office programs have a new tab that you have used before in OneNote 2016: Draw. This 
will work much the same as the OneNote Draw tab, with the ability to markup a document 
(especially cool with a stylus), and even replay the drawing action. 

 
Back to top 

 

EXCEL 

AI: Convert Data in Excel 

Excel has a couple of data types that can be identified with AI. Currently the two options are: 
stocks, and geography. 
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1. These options live on the Data tab, Data Types group. 

 

2. Select the data to be converted. Zip codes work really well with geography. Where 
possible try to use zip codes, but this is also a developing software, so may get more 
refined with time. 

 

3. Select Geography. 
4. The data is converted to live information. There are cards that can be clicked on to the 

left of the zip code for more information. 
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5. To Extract Data: select the newly transformed data, and click on 
the square in the upper right to see a list of options. 

 

 Look how quickly that data was extracted! 

 

 Click on any of the extracted data fields, and look in the formula bar. Notice this is a 
formula that is inserted. Formulas are always updating. This is especially relevant with 
the stocks feature. 
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New Functions 

You may not yet have access to these functions, but check for them as you receive updates. 
You won’t want to miss out on these.  

XLOOKUP 
Hold on to your hats, because the VLOOKUP slayer has arrived. Remember that VLOOKUP 
returns results from the right side of a vertically oriented table. 

XLOOKUP has the same (and more) 
functionality as VLOOKUP, with far fewer 
foibles.  

 XLOOKUP can search to the right, or 
left.  

 It can return a range of results, several 
columns at a time.  

 You no longer have to worry about 
column index number or the pesky 
default “true” match in VLOOKUP. 

 As a bonus, you have the ability to set 
a value to return if a match is not found. 
No more “#N/A” errors for you! 

 

 XLOOKUP is so intuitive, you will have no problem at all learning how to use it. 

The layout is: 

 =XLOOKUP (Lookup_value, Lookup_array, return_array, If_not_found [optional], 
match_mode[optional], search_mode[optional]) 

 

New Dynamic Array Formulas 
Each of these array formulas will spill into multiple cells to create a new list of data. 

 UNIQUE: returns unique values from a list 
 SORT: returns a sorted version of a list  
 SORTBY: sorts by the contents of one range by the contents of another. 
 FILTER: returns a filtered version of a list 
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OUTLOOK 

Simplified Ribbon View 

Outlook is experimenting with a Simplified Ribbon view.  

This turns the old ribbon we know and love: 

 

Into a slightly different appearance: 

 

I am still formulating an opinion on what I think of the new view. I can’t wait to hear what you 
think! 

 To turn on Simplified Ribbon view, right click anywhere on the ribbon and select Use 
Simplified Ribbon. 

 

Back to top 
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ONENOTE 2016: THE CONTINUING SAGA 
Although Microsoft is not releasing a desktop application of OneNote in 365, opting instead to 
offer a OneNote App through the App store, they will continue to support and update the 
OneNote 2016 desktop application. At this time, we recommend using the desktop application 
as it retains some features currently not present in the App, including: 

 The ability to store OneNote Notebooks locally (including shared drives) 
 The ability to export OneNote Notebooks. 

When Desktop Support sets you up with Office 365, they will make sure you have a OneNote 
2016 desktop application so you can continue your work in OneNote as you are accustomed. 

Back to top 

 

MORE UPDATES COMING 
This was just a brief foray into the new and exciting features coming soon in your Office 365 
suite. Stay tuned for more information. Follow our blog (below) and attend a future PowerUp! 
Session for the latest and greatest! 

Back to top 

 

HOW DO I UPDATE TO MICROSOFT OFFICE 365? 
There is a different process for setting up Office on your work and home computers. We want to 
make sure you have the right version in the right location! 

At Work 

Contact the Help Desk: helpdesk@wichita.edu, or extension 4357, and request that they put in 
a ticket to have your work computer updated. 

At Home 

Did you know you get up to 5 free downloads of Microsoft Office for home use? What a deal! If 
you would like to see detailed instructions for accessing your free downloads, please visit: 
wichita.edu/mstraining.  

mailto:helpdesk@wichita.edu
https://wichita.edu/mstraining
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 Under Learn More, select Microsoft Downloads for Home Use. 

Back to top 

 

POWER USER PROGRAM 
Are you interested in becoming a WSU Microsoft Office Power User? Attend a suite of ITS led 
training sessions within one year and you will receive a digital credential, a certificate, and a lot 
of useful knowledge! For more information, please visit: wichita.edu/poweruser 

Back to top 

 

OFFICE BYTES BLOG 
Do you want to receive bite sized tips and tricks on Microsoft Office products? Check out the 
Office Bytes blog! 

You can find it here: 

 blogs.wichita.edu/itstraining 

Or by visiting the Power User page: 

 wichita.edu/poweruser 

You can also sign up there to receive email notifications as I post new topics.  

 

Back to top 

https://www.wichita.edu/services/its/mstraining/Employee365myWSUTraining.pdf
https://wichita.edu/poweruser
https://blogs.wichita.edu/itstraining
https://wichita.edu/poweruser
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CONTACT INFORMATION 

Help Desk 

Email: helpdesk@wichita.edu  

Phone: (316) 978 4357 

 

Applications Training 

Email: its_training@wichita.edu  

Phone: (316) 978 5800 

 

Ali Levine 

Email: ali.levine@wichita.edu  

Phone: (316) 978 3901 

 

Back to top 
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